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File Manager Jr. 95
For Microsoft® Word for Windows® 95, Version 7.0

Using File Manager Jr., you can:
· Move, copy, delete and rename files without leaving Word.

· Print files without having to open them.

· Quickly open existing files.

· Delete backup files in one or more folders.

· Recover deleted files.

· Create and delete file folders without leaving Word..

· Manage a personal address list.

Q.   Why use File Manager Jr. when you can use the Windows Explorer to 
perform many common file-management operations?

A.   One reason is that Explorer is not built into Word for Windows.  It’s a 
separate program.  You can’t use it without leaving Word.  But leaving Word is 
unnecessary if you’re using File Manager Jr., because it is attached directly to the 
Word program.  If you spend much of your time in Word, and perform more than
a few file-management operations in a typical work session, you’ll find File 
Manager Jr. a handy alternative to Explorer. 

To illustrate, suppose that you want to use Explorer to delete a file in the folder 
C:\MSOFFICE\WINWORD\REPORTS.  First you’ll need to use the Taskbar to switch 
from Word to Explorer (assuming Explorer is running).  If the WINWORD folder is
not visible in Explorer, you’ll need to display the folder name by clicking the plus
sign next to the MSOFFICE icon.  If the names of your WINWORD subfolders are not
visible, you’ll need to click the plus sign next to the WINWORD icon.  Then you’ll 
need to find the REPORTS folder and click the name of the file you want to delete. 
Then you'll need to drag the file to the Recycle Bin or choose Delete from the 
File menu.  Then you’ll need to use the Taskbar to switch back to Word.

Using File Manager Jr. to perform the same operation, you would:
1. Click the Delete command button.

2. Double-click the name of the REPORTS folder.

3. Double-click a filename.  Job done.
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Trying before buying
This is an evaluation copy of File Manager Jr.  It gives you access to the 
program’s basic file-management commands, but not to all commands.  You may 
use this trial copy for 30 days to get the feel of the software.  If you want to keep 
using File Manager Jr. after the 30-day trial period, you must purchase a 
registered copy of the program.

For information about ordering a registered copy—and getting access to all the 
File Manager Jr. commands—see page 15.

Conventions used in this guide
Names of documents and folders appear in small capitals.  Words to be typed by 
the user appear in small bold capitals.  Section titles are boldfaced when cited in 
the text.

Command buttons in File Manager Jr. dialog boxes may be referred to simply as 
“commands.”  

In typing instructions, the plus sign and comma have shorthand meanings when 
used between names of keys.  A plus sign (as in “Alt+S”) means that the first key 
is to be held down while the second key is pressed.  A comma (as in “Tab, B”) 
means that the first key is to be pressed and released before the second key is 
pressed.

Working with folders
By default, File Manager Jr. uses the main Word folder as the master folder.  
(The main Word folder is where Word’s program files are installed.   They are 
commonly installed in C:\MSOFFICE\WINWORD.)  If you run File Manager Jr. using
the default setup, you can store and access documents in the main Word folder 
and in four levels of subfolders below the main folder.

If you want to store your documents elsewhere, you can designate any folder on 
any hard drive as the master folder.  For more information, see The master 
folder on page 5.

Starting the program
To make it easy to start File Manager Jr., you should assign the program to a 
shortcut key and/or toolbar button.  (Step-by-step directions are found on pages 
13 and 14.)
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When you start File Manager Jr., you see the main menu.  One column of 
commands appears on the left side of the menu and another on the right.  A blank 
Folder box appears at the center.

If you select a command in the left-hand column, a list of folders appears in the 
Folder box (as illustrated below).  You can then choose the folder in which you 
want to carry out the command you have selected.

Commands in the right-hand column are enclosed in a free-standing box and 
operate independently, making no use of the Folder box.  Most commands in the 
right column are available only to users with registered copies of File Manager Jr.
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Performing common operations
The following examples assume that C:\MSOFFICE\WINWORD is the master folder.

Mouse   To open a file stored in C:\MSOFFICE\WINWORD\MEMOS, first click the 
Open button on the left side of the main menu.  Then double-click the name 
MEMOS in the Folder box.  A list of files appears.  Double-click a filename.

To open a file stored in a subfolder of the MEMOS folder, first click the Open 
button.  Then single-click the name MEMOS in the Folder box and click the 
elongated Sub button.  A list of subfolders appears.  Double-click a subfolder 
name.  Then double-click a filename.

Note   Because of its extended length, the Sub button is always within easy reach 
when needed.  After selecting a name anywhere in the Folder box, you can get to 
the Sub button by moving the mouse pointer only slightly to the left.

To use the mouse to move, copy, delete, rename or print a file, first click the 
appropriate command button.  Then choose a filename just as you would if you 
were opening a file.

Keyboard   To open a file stored in C:\MSOFFICE\WINWORD\MEMOS, first select 
the Open button by typing the letter O.  Then highlight MEMOS in the Folder box 
and press Enter.  A file list appears.  Highlight a filename and press Enter.

To open a file stored in a subfolder of the MEMOS folder, first select the Open 
button.  Then highlight MEMOS in the Folder box and choose the Sub button by 
pressing Alt+S or Tab, S.  A list of subfolders appears.  Highlight a subfolder 
name and press Enter.  Then highlight a filename and press Enter. 

To use the keyboard to move, copy, delete, rename or print a file, first press a 
letter key to select the appropriate command button.  Then choose a filename just 
as you would if you were opening a file.

Tip   A list box may contain the names of many files or folders.  If the name you 
want is buried in a long list, try this shortcut: On the highlighted line at the top of 
the list box, type the first few characters of the name you’re looking for.  Then 
tap the down-arrow key once.  The first name beginning with the characters you 
typed will be highlighted.  To choose that name, just press Enter.

General   When you select a command in the left-hand column, the program 
assembles a list of your Word folders and displays the list in the Folder box.  If 
you have many folders, it may take a moment for the list to appear.

If you select a button in the left-hand column and discover that you picked the 
wrong button, you can reselect.  Example: If you select the Delete button when 
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you meant to select the Copy button. just click Delete.  Or press Alt+D or Tab, D.

If you want to restart the program, choose the Home button.  To choose Home 
using the keyboard, press Alt+H or Tab, H..

When you choose the Sub button to display a subfolder list, a Back button 
appears in the group of controls below the Folder box.  If you choose the Sub 
button by mistake, you can use the Back button to go back one step.  To choose 
the Back button using the keyboard, press Alt+B or Tab, B..

Note    Back buttons appear in many File Manager Jr. dialog boxes.  Generally, 
choosing a Back button closes a dialog box and redisplays the previous box.

To access a file in drive A or B, select a command in the left-hand column and 
then choose a drive button.  To choose the Drive A button using the keyboard, 
press Alt+V or Tab, V.  To choose the Drive B button, press Alt+E or Tab, E.

To run one of the commands in the column on the right side of the main menu, 
simply click a button or press a letter key.  Example: To run the Back Up 
command, click the Back Up button or press the B key.

Note    For brevity, most step-by-step examples found later in this guide omit 
keyboard directions.  Such directions appear only when procedures used to 
perform keyboard operations have not been covered by earlier examples.

The master folder
Unless you tell the program otherwise, the main Word folder will be the master 
folder.  If C:\MSOFFICE\WINWORD is the master folder, you can store and access 
files in that folder and in four levels of subfolders.  Examples:
First level:  C:\MSOFFICE\WINWORD\REPORTS.                                                        
Second level:   C:\MSOFFICE\WINWORD\MEMOS\SALES.                                           
Third level:  C:\MSOFFICE\WINWORD\MAIL\PERSONAL\OLD.                                    
Fourth level:  C:\MSOFFICE\WINWORD\ARTICLES\COMPUTER\APPS\WORDPROC.

If you don’t want to use the main Word folder as the master folder, click the 
Setup button on the main menu and then click the Master Folder button.  In the 
next box, type the name of the folder you want to use as the master folder. If the 
folder doesn’t exist, File Manager Jr. can create it.  The folder can be on any hard
drive.  Example: If you have a D drive and you make D:\DOCS the master folder, 
you can store and access files in D:\DOCS and in four levels of D:\DOCS subfolders.

Tip   Though you can work with files in subfolders three or four levels below the 
master folder, you may find it advisable to use such subfolders sparingly.  The 
more subfolder levels you have to deal with, the longer it takes to access files, 
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regardless of the method used.

The command list
Open   The command opens a previously saved file.

You can also use the Open command to get information about files.  Example: To
see which files are stored in C:\MSOFFICE\WINWORD\MEMOS, click the Open 
button and then double-click the name MEMOS in the Folder box.  After checking 
the file list, you can close the Open File box by clicking Cancel or by pressing the
Esc key.

Move   The command transfers a file from one folder to another.  It can also be 
used to move a file to or from a disk in a floppy drive.

Procedure: To move a document from C:\MSOFFICE\WINWORD\GENERAL to C:\
MSOFFICE\WINWORD\MISC, first click the Move button.  Then double-click the 
name GENERAL in the Folder box and double-click the name of the file you want 
to move.  A Destination box appears.  Double-click the name of the MISC folder.

If you want to move a file to a subfolder of C:\MSOFFICE\WINWORD\MISC, single-
click the name MISC when the Destination box appears.  Then click the Sub button
to display a list of subfolders.

To move a file to drive A or B, click the appropriate drive button in the lower 
part of the Destination box. 

Copy   The command creates a duplicate of a file and sends the duplicate to a 
destination of your choice, leaving the original copy of the file in place.  The 
Copy command is structurally similar to the Move command.

Delete   The command erases a file.  By default, File Manager Jr. does not ask 
for confirmation before deleting a file.  If you want to be asked, choose the Setup 
button on the main menu and then choose the File Delete Confirmation button.

Kill Backups   The command erases backup files in one or more folders.  
Procedure: Click the Kill Backups button and then double-click a folder name.  
The next box displays the name of the selected folder and gives you a choice: 
You can delete backup files in the selected folder only, or you can delete backups 
in the selected folder and in any subfolders of the selected folder..

To delete backup files in all your document folders, first click the Kill Backups 
button and then double-click the name of the master folder.  In the next box, 
indicate that you want to delete backups in the selected folder and its subfolders.

Before using the command, close any open backup files.

6



Kill Backups does not delete backup files on floppy disks.  When you select the 
command, the Drive A and Drive B buttons are dimmed and inaccessible.

Rename   The command changes the name of a file.  When asked to enter a new
name for a file, do not type a folder name or subfolder name ahead of the 
filename.  Example: Don’t type C:\MSOFFICE\WINWORD\MEMOS\BAKER.DOC .  
Just type BAKER.DOC.  (If you type a filename without a one-to-three-character 
extension, the program adds a DOC extension.)

A filename may not contain an asterisk, colon, semicolon, quotation mark, 
question mark, angle bracket (<  or  >), slash ( / ), backslash ( \ ) or pipe symbol ( |
).

Print File   The command allows you to print documents without opening them. 
You can print any document in any Word folder.  After choosing a document to 
print, you’re asked whether you want to print one copy of the complete file.  If 
you answer Yes, printing starts.  If you answer No, a new box appears so that you
can tell Word to print multiple copies or only certain pages.   

Save New   The command is used to specify where a file will be stored when 
saved for the first time.  Example: If you have a new file onscreen and want to 
store it in C:\MSOFFICE\WINWORD\REPORTS, select the Save New button and then 
double-click the name REPORTS in the Folder box.  When asked to enter a name 
for the new file, don’t type a path ahead of the filename.  Example: If you’re 
naming the file DOCK.DOC, don’t type C:\MSOFFICE\WINWORD\REPORTS\
DOCK.DOC.  Just type DOCK.DOC.  (If you type a filename without a one-to-three-
character extension, the program adds a DOC extension.)

The command cannot be used to store a new file on a floppy disk.  When you 
click Save New, the Drive A and Drive B buttons are dimmed and inaccessible.

Get Stats   The command displays statistical information about files in a 
specified folder.  Example: Three files are stored in the REPORTS folder.  You 
want a word count for each file.  Procedure: Select the Get Stats button and then 
double-click the name REPORTS in the Folder box.  The names of the three 
REPORTS files appear in a list box.  Double-click the name of the first file.  
Statistical information about the file appears on the right side of the screen.  
Double-click the name of the second file to display statistics for that file.  Then 
double-click the third filename.

You can also get statistical information about files in a subfolder.  After selecting 
the Get Stats button, single-click a name in the Folder box and then click the Sub 
button to display a list of subfolders.  Choose a subfolder name.  Then double-
click a filename.
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Back Up   The command sends a copy of the active document to a backup disk 
in the A drive.  Any previous backup copy is overwritten.

If you want to use the B drive for backups instead of the A drive, choose the 
Setup button on the main menu.  Then choose the Change Backup Drive button.

Print Selection   The command prints a selected block of text.  First highlight 
the text you want to print.  Then click the Print Selection button.

Find File   The command helps you locate a file when you can’t remember 
where you stored it or can’t remember its name.

When you choose the Find File button, you’re asked whether you want to search 
for a filename or for text.  If you know the name of the file you’re looking for, 
choose the Filename button.  Type a name in the next box and choose OK.  You 
can use the asterisk as a wild-card character.  Example: If you’re looking for a 
file called ANTIDISESTABLISHMENTARIANISM.DOC, just type ANTIDIS* and press 
Enter. 

If you don’t know the name of the file you’re looking for, choose the Text button.
In the next box, type a word or phrase that is likely to be found only in the file 
you’re looking for.  Then choose OK.  A new box appears.  You can limit the 
scope of the search by entering a filename extension in this box.  If you enter 
DOC, only files with DOC extensions will be searched.  This can save time.

(Note that a Word 95 filename can have more than one extension.  If you have a 
file called JAMISON.RPT.DOC and you limit the scope of a search to files with RPT 
extensions, the JAMISON.RPT.DOC file will be searched, even though RPT is not the
last extension in the filename.)

File Info   The command displays a word count, a page count and other 
statistical information about the active document.

Folder Works   The command is used to create and delete Word folders.  For 
additional information, see More about Folder Works later in this guide.

Address List   The command is used to manage address lists.  For additional 
information, see More about Address List later in this guide.

Junk Closet   The command is used to store text temporarily in a holding file 
or to retrieve text from the holding file.  For additional information, see More 
about Junk Closet later in this guide.
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Quit Word   The command closes any open files, then shuts down Word for 
Windows.  If any open files have been changed since they were last saved, the 
changes are preserved.

If you have entered text in a new document but have not yet named the document,
you’ll be asked to supply a name before quitting Word.

Trash Bin
Overview: Using the File Manager Jr. Delete command, you can erase files from 
within Word instead of having to leave the program to erase them.  When files 
are erased from within Word, Windows 95 does not provide backup protection by
sending the files to the Recycle Bin.  But File Manager Jr. allows you to protect 
such files by having them sent to a Trash Bin folder.  

If you don’t want to use the Trash Bin feature, skip the rest of this section.  Files 
you erase with the Delete command will simply be purged.  Keep in mind that 
such files may be unrecoverable.

To create a Trash Bin folder that will protect deleted files, do this:

On the main menu, choose the Setup button.  In the Setup dialog box, choose the 
Create Trash Bin button.  Enter a path identifying the folder in which you want to
keep erased files.  Example: C:\TRASHBIN.  If the folder doesn’t exist, File 
Manager Jr. can create it.  The folder can be on any hard drive.

You can quickly recover a deleted file from the Trash Bin.  Procedure: On the 
main menu, click the Trash Bin button (below the Folder box).  Then click the 
Recover button.  A list of Trash Bin files appears.  Double-click the name of the 
file you want to recover.  A Destination box appears.  Choose a destination.  You 
can place the file in any of your Word document folders or send it to a floppy 
disk.  Directions appear onscreen.

If you delete a file that has the same name as a file already in the Trash Bin 
folder, copies of both files are preserved.  A plus sign is added to the name of the 
newer file to distinguish it from the older one.  If you delete a third file with the 
same name, it goes to the Trash Bin with two plus signs after its name.

The Trash Bin does not capture files deleted with the Kill Backups command.

You can discard Trash Bin files when you know you’ll have no further use for 
them.  First click the Trash Bin button and then click the Discard button.  Files 
can be discarded individually or all at once.  Directions appear onscreen.  Once 
you discard a file, File Manager Jr. cannot recover it.

If you have set up a Trash Bin folder and no longer wish to use it, choose the 
Setup button and then choose the Remove Trash Bin button.  Do not use any 
other method to delete the Trash Bin folder.  File Manager Jr. must monitor the 
deletion..
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More about Folder Works
When you choose the Folder Works button, a dialog box displays two command 
buttons: Create Folder and Delete Folder.  If you choose the Create Folder button,
the name of the master folder appears in an input box.  A backslash is appended 
to the folder name.  Example: C:\MSOFFICE\WINWORD\.
To create a folder, type a name immediately after the backslash and choose OK.  
Example: If you add REPORTS to the path C:\MSOFFICE\WINWORD\ and then 
choose OK, the folder C:\MSOFFICE\WINWORD\REPORTS is created.

You can create a folder and a subfolder at the same time.  Example: The master 
folder is C:\MSOFFICE\WINWORD.  You want to create a JOURNAL folder and a 
JOURNAL subfolder called JULY.  Procedure: When the name of the master folder 
appears in the input box, type JOURNAL\JULY after the last backslash, so that the 
full line reads C:\MSOFFICE\WINWORD\JOURNAL\JULY.  Then choose OK.  (If 
the JOURNAL folder already exists, only the JULY subfolder is created.)

Note that Windows 95 disallows some characters in folder names.  You can’t use 
an asterisk, colon, quotation mark, question mark, angle bracket (< or >), slash 
(/), backslash (\), or pipe symbol ( | ) as part of a folder name.  But you can use 
the backslash to separate folder names when you run the Create Folder 
command..

To delete a Word folder, choose the Folder Works button and then choose the 
Delete Folder button.  Directions appear onscreen.  

More about Address List
When you choose the Address List button, you see a dialog box with six 
command buttons.  The first button is Copy Address.

The Copy Address command places an address block in a business letter, saving 
you the trouble of typing an inside address.  The block is copied from a file in 
which you can store frequently used addresses.  The file is called NAMELIST.FMJ.  
It was placed in the main Word folder when you installed File Manager Jr..

To copy an address block, first place the insertion point anywhere on the top line 
of the body of your letter.  Choose the Address List button and then choose the 
Copy Address button.  In the next box, type a name listed in your address file.  
You can type a last name, first name, street name, city name or some other 
combination of characters known to be in the address block you want to copy.  
(Do not type the addressee’s full name.)  When you choose OK, the program 
searches for a listing containing the characters you typed.  If the first listing found
is not the one you’re looking for, choose the button labeled Skip This Listing.

The second command in the Address List dialog box is Print Envelope.  It works 
much like the Copy Address command.  Have an envelope ready to print when 
you run the command.
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By default, the Print Envelope command uses the Courier typeface and does not 
print a return address on your envelopes.  You can override either or both 
defaults.  Procedure: On the main menu, choose the Setup button.  In the Setup 
dialog box, choose the Envelope Format button.  Select a font and a point size.  
When asked whether you want a return address printed, choose the Yes or No 
button.  If you choose Yes, Word will use whatever address it finds in your 
Mailing Address box.  To see what’s in that box, first display the Tools menu in 
Word.  Then choose Options and click the User Info tab.

The third command in the Address List dialog box is Add Listing.  It’s used to 
create listings and add them to the address file.  When you choose the Add 
Listing button, an empty address box appears.  You type information in the box.  
A completed box might look something like this:

You can skip some fields.  Examples:  If you want to record a company address 
rather than the address of an individual, skip the first two fields and type the 
company name in the Organization field.  If you don’t need to use both the 
Address1 and Address2 fields, you can leave either one blank.  You must type 
something in at least one of the first three fields.

If you want to use a courtesy title such as “Ms.” or “Mr.,” place the title ahead of 
the first name.  In the Horatio Blunt address listing illustrated above, “Mr. 
Horatio D.” could have been typed in the FirstName field in place of “Horatio 
D.”

If you want to use a middle name or middle initial, just add it to the FirstName 
field.  See the FirstName field in the Horatio Blunt listing.

If you want to use an abbreviation such as “M.D.,” “Esq.” or “Jr.” in an 
addressee’s name, place the abbreviation at the end of the LastName field.  See 
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the Horatio Blunt listing.

If a listing includes a Salutation field, the text entered in that field is used as part 
of a salutation when the listing is copied to a letter.  The Horatio Blunt listing, for
example, would be copied with a “Dear Mr. Blunt:” salutation.  If “Horatio” had 
been typed in the Salutation field instead of “Mr. Blunt,” the address would be 
copied with a “Dear Horatio:” salutation.

The Phone&Misc field is used to store telephone numbers and miscellaneous 
information.  The field normally accommodates two lines of text.  Note, however,
that you can use no more than 255 characters in an entire address listing.  You 
may not be able to enter two full lines of text in the Phone&Misc field if some 
earlier fields are unusually long.  Ordinarily, the 255-character limit should not 
present a problem.

If you’re using both lines of the Phone&Misc field, you don’t need to press Enter 
when you reach the end of the first line.  The cursor wraps to the second line 
automatically.  

To save a completed listing, click the OK button or press Tab and then Enter.  If 
you try to save a listing without having filled in any of the first three fields, an 
error message appears.  In that event, choose OK to redisplay the incomplete 
listing so that you can correct the omission.

The fourth command in the Address List dialog box is Delete Listing.  Use it 
when you want to remove a listing from the address file.  After choosing the 
Delete Listing button, enter a name just as you would if you were using the Copy 
Address or Print Envelope command.  Then choose OK.

The fifth command, View Listing, is used to look up information in the address 
file.  Example: If you need to look up Horatio Blunt’s street address, telephone 
number or fax number, choose the View Listing button and type BLUNT or 
HORATIO in the next box.  Then choose OK.  (If a listing contains a salutation 
field, such as “Mr. Blunt,” that field is omitted when the listing is displayed.)

The last command in the Address List dialog box is Fix Listing.  If you discover a
typing error in one of your listings, you can use the Fix Listing command to 
correct the error.

A fictitious Horatio Blunt listing has been placed in the File Manager Jr. 95 
address file for demonstration purposes.  If you have the full version of File 
Manager Jr., you can use the Horatio Blunt listing to experiment with the Copy 
Address command, and also with the Print Envelope, View Listing, Fix Listing 
and Delete Listing commands.  But see the following note.

Caution   If you created an address list with an earlier version of File Manager 
Jr., that list was preserved when you installed File Manager Jr. 95.  But the list 
must be reformatted before you attempt to use it with the new version of the 
program.  The reformatting takes only a minute.  See the READ_1ST.TXT file 
supplied with the full version of File Manager Jr. 95.
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More about Junk Closet
The Junk Closet command is used to set aside text you want to remove from the 
active file but keep available for possible use later.

To store text in the junk closet, highlight a block of text, choose the Junk Closet 
button and then choose the Store Selection button.  The text is removed from the 
active document and sent to a file called JUNK.FMJ.  The file was placed in 
Word’s home folder when you installed File Manager Jr.

To find text in the junk file, choose the Junk Closet button and then choose the 
Open Closet button.  A Find box appears.  Type a word or phrase peculiar to the 
block of text you’re looking for.  Then press Enter.  If the junk file is small and 
you don’t need to run a search, press Esc to close the Find box.

To retrieve a block of text from the junk file, select the text and place it on the 
Windows Clipboard.  Then close the junk file and copy the text from the 
Clipboard to the active file.

A separator mark appears before each block of text stored in the junk file so that 
you can easily tell where one block ends and the next begins.

To delete text from the junk file, first open the junk closet.  Highlight the text you
want to erase and press the Delete key.  Then choose Close on the File menu and 
answer Yes when asked whether to save changes.

Assigning File Manager Jr. to a shortcut key
1. On the Tools menu, choose Customize.

2. In the Customize dialog box, click the Keyboard tab (at the upper right).   

3. In the Categories list box, click Macros.

4. In the Macros list box (to the right of Categories), click the name FileMgrJr.

5. Click the box labeled Press New Shortcut Key.  Press a key or combination of
keys.  Example: If you want File Manager Jr. to start when you hold down
Ctrl and strike J (for “Junior”), press the Ctrl key and, without releasing it,
press J.

6. Choose Assign.

7. Choose Close.

Note   When File Manager Jr. is installed, it is assigned to a special shortcut key 
(Alt+Ctrl+Shift+Backspace).  That key performs an internal function and should not 
be removed.  It won’t interfere with your own File Manager Jr. shortcut key.
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Assigning File Manager Jr. to a toolbar button
· On the Tools menu, choose Customize.

· In the Customize dialog box, click the Toolbars tab (at the upper left).

· In the Categories list box, click Macros.

· In the Macros box (to the right of Categories), click the name FileMgrJr. and 
keep the left mouse button depressed.  A rectangular outline appears.  
Drag the outline to a position on the toolbar and release the mouse button.

· In the box labeled Text Button Name, type a short name, such as JR.

· Choose Assign.

· Choose Close.

Starting File Manager Jr. automatically
If you want the File Manager Jr. menu to appear whenever you start Word, 
choose the Setup button on the main menu and then choose the AutoMenu 
button..  

Uninstalling File Manager Jr.
1. In the main Word folder, delete JUNK.FMJ, LICENSE.FMJ, NAMELIST.FMJ, 

READ_1ST.TXT and TUTOR.FMJ.

2. In the folder where Word templates are stored, delete FMJ.DOT. 

3. On the Tools menu, choose Macro.  In the macro list box, delete all macros 
with “FileMgrJr” in their names.
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Ordering information
You can replace this evaluation copy of the program with a full version by 
sending an order to:

Charles Maher
409 North 18th Street
Coeur d’Alene, ID 83814-5460

* * * * * * * * * * * * * * * * * * * * * * * * * * * *
*                                                     *
*               ====================                  *
*               O R D E R    F O R M                  *
*               ====================                  *
*                                                     *
*   Please send one copy of File Manager Jr. 95 to:   *
*                                                     *
*   NAME:    ______________________________________   *
*                                                     *
*   ADDRESS: ______________________________________   *
*                                                     *
*            ______________________________________   *
*                                                     *
*            ______________________________________   *
*                                                     *
*                                                     *
*   I enclose a check or money order for $19.95,      *
*   made payable to Charles Maher. Idaho residents:   *
*   Add sales tax.                                    *
*                                                     *
* * * * * * * * * * * * * * * * * * * * * * * * * * * *

If you have a MasterCard or Visa  account, you can call toll-free to order.  Dial   
1-800-215-3693 between 6 a.m. and 3 p.m. Pacific time, Monday through Friday.

If you have a modem, you can use a 24-hour number: 1-800-501-5799.  Indicate 
that you are ordering a  product developed by vendor 3864.  

You can also order on CompuServe.  Type GO SWREG.  The CompuServe 
Registration ID for File Manager Jr. is 5059.    

Each registered user receives a printout of the documentation and a 3.5-inch disk 
containing the full version of File Manager Jr.  Registered users are entitled to 
support and to discounts on future releases.  Support is provided by telephone 
(208-664-3864), fax (208-664-9743) and e-mail (76476.3400@compuserve.com).
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